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This e-book is a gateway to the many secrets in the 
SERTICA fleet management system and includes 
everything from simple shortcuts to best practice 
ideas. The secrets will help you optimize the daily 
use of SERTICA and give you maximum value of the 
system. 

The e-book is intended for the frequent SERTICA 
user or a new curious user. If you need help finding 
out how to put these tips to use, please contact 
SERTICA support or your regular contact person at 
Logimatic.

Unlock the Secrets
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Shortcuts
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F1 Help

F2 Address Book

F3 Account

F4 Component 

F5 Update Screen

F6 Job

F7 Tree Structure

F8 Job History

F9 Item / Spare Part

F11 Requisition

F11 + Shift Request for Quote

F11 + Ctrl Purchase Order

F12 Job List

Ctrl + D Delete

Ctrl + F Search

Ctrl + F Recall Last Search

Ctrl + M Use to open ex. Job text 

in Multiline editor

Ctrl + N New

Ctrl + Shift + N Copy

Ctrl + O Options

Ctrl + Q Cancel

Ctrl + S Save

Ctrl + T Task List

Alt + U Search for Screen or Unit

CTRL + Space Move cursor to 

search field

Ctrl + Enter Create new line in a 

reference grid
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#2 Some shortcuts can be found in SERTICA under File → 
Help → What’s New (internet access required). 
View a full list of shortcuts. 

#3 If you have the cursor in the date field you can insert 
today’s date by pressing d.

#4 Use Alt + ↓ to open a search box in grids. Hereby you 
can for example select measure unit on a requisition 
position.

#5 You can use Ctrl + Enter to create a new line in a 
reference grid when this has focus. E.g. a position on a 
requisition.

#6 Use Ctrl or Shift to mark multiple lines. As an 
example, you can mark several items in an item list and 
thereby add them all to a requisition at once.
 
#7 Clicking the middle mouse button on an open screen 
tab in SERTICA closes the tab instantly.

#8 Double-clicking a row in a reference grid, e.g. Job 
Procedure on the job screen, will open a new tab 
showing details of the row you clicked. Pressing Ctrl + F4 
will close details and take you back to the original screen.

#1 The shortcut key only works if the screen is available 
in the mode you are in. Some shortcuts work on both 
office and unit. Others only work on the unit, because 
the screen is only available on the unit, for example F6 
Job and F8 Job History.
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#9  
Default values such as language can be set by the 
administrator for new users in Options under User.

User
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#10
It is possible to show the Task List screen on login to 
ensure the users see relevant dashboards. This can be 
activated on the user screen. It can also be configured 
which dashboards a user should see on the task list.

#11 
The administrator can enable spell checking on text 
fields in SERTICA. Spellchecking is enabled from the user 
options or from the user screen.



Overview
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#12
Use Unit Groups to get an easy overview of your fleet.

#13
It is always possible to export your overview list on a 
screen to Excel. Just press the Export icon.
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Jobs

#14
You can share your saved queries on the Job List with 
other users. Select which users you want to share the 
query with inside the save dialog.

#15
You can see when future jobs will happen (further 
than the next job instance) using the Show Future 
Job Instances button on the Job List screen. Note: This 
requires pre-calculation by using the task scheduler with 
the parameter /CalculateFutureJobInstances.

Future job instances can also be listed using the built-in 
report in the Analytics module.
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Document
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#16
You can build alternative views of structures in 
Document Tree using Document Folders or Alternative 
Structures. This can be used to show a selection of 
specific documents relevant for different users.

#17
SERTICA has a build-in previewer for documents. It works 
with various types of documents such as MS Office & 
PDF. It requires no installation of third-party programs 
on client computers and will work fast and reliable. The 
SERTICA previewer can be activated in options by the 
administrator.
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Actionboard

#18
Users can make and save their own private queries on 
the action board. The query can include units, activity 
types, event types and certificate types. This can be 
enabled with user rights.

#19
It is possible to create predefined queries on the action 
board and share them with the entire fleet. This makes 
it possible to create custom queries that matches your 
organization and share them. This can be enabled with 
user rights.

If your administrator has enabled this function, you just 
select the items you wish to show on the dashboard 
and save it (save button in the top right corner). The 
save dialog lets you decide if the saved query should be 
private or public (shared with other users).



18 The Secrets of SERTICA

Analytics
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#20  
You can link Analytics reports to many screens in 
SERTICA. As an example, you can add a button to 
the Component screen to show Top 10 Breakdown 
Components, or to the Job History screen to show 
related job histories for the past year.

It is possible to extract data based on a selected report 
created in Analytics. You link the reports to the screen 
called Analytics Screen Configuration found in the 
office menu. Output can be exported directly into 
SERTICA or Excel. 

#21
Use Custom Analytics if you need advanced reports 
or reports combining special fields and data. For ease 
of use, you can add the reports to the Task List for 
everybody to use or you can restrict access. 

Examples of reports: 

•	  Internal KPI’s analyzing the efficiency of the 
procurement department 

•	  Turn-around time from quote to purchase order to 
midpoint receival at transit warehouse 

•	  Individual performance compared with company 
targets 
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Email Notifications
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#22 
SERTICA can send email notifications for various types of 
events in SERTICA. 

Examples of notifications:
 
•	 A form needs approval
•	 A certificate is about to expire
•	 A job is close to its due date 
•	 A request for quote is rejected
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Search
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#23 
You can configure the initial search on screens. This 
makes it possible to show data when the screens open, 
based on the criteria you want. Initial searches can be 
maintained in the search dialog.

#24 
When looking up structured data in some search 
dialogs, you can switch to a tree view to look up 
the record you need. For example, when finding a 
component or item for a job. 
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#25 
Ctrl+F opens the search dialog. The secret is that 
Ctrl+F+F (hold Ctrl. and enter two F’s) recalls the last 
search - if you just need to adjust one parameter in a 
complex search.
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#26 
You can search for specific words in PDFs and Word 
documents in Document Management and the 
Management System modules. This can be setup on the 
server and can afterwards be used by all users.

#27 
Use the CTRL+Space shortcut to move the cursor to the 
search field in the top of SERTICA. This is a quick way to 
start a search.
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#28 
If the currency is changed on a purchase order, you can 
still see which currency the original approved amount is 
in. This is included in the approval grid on the purchase 
order. 
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Procurement

#29 
In Procurement you can import the latest currency rates 
from a range of supported sources, such as The Danish 
National Bank or ECB. This can be configured in options.



28 The Secrets of SERTICA

Settings
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#30 
Configure SERTICA to update item prices from suppliers 
when ordering a purchase order in Options. When a 
purchase order is ordered, the supplier prices of those 
items will be updated with the price information from 
the purchase order. 

Find the settings in options under Office → Procurement 
→ Purchase Order → Item prices.



30 The Secrets of SERTICA

#31 
In Favorites you can build your own favorite menu list. 
Right click an item in the Office or Main menu and 
select to add it to Favorites.
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#32 
SERTICA offers history mode in most screens, allowing 
you to see change history for a specific record. On 
all standard screens in SERTICA, you have a button 
named Changes mode. Find the record you wish to see 
the history for and press the button to see a list of all 
changes. Press the button again to close the change log.
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#34 
If you “get lost” when moving windows around when 
changing the layout, just press the Reset Screen Layout. 
This will take you back to the initial layout of the screen 
you are currently on.
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#33 
Move windows around as you like and build your own 
layout. 

Screen Layout
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#35 
Double-clicking the Home tab above the action bar 
unpins and hides the action bar, making more room for 
the detail and reference areas on screens.

#36 
Your administrator can create customized button layouts 
and thereby simplify the use of your SERTICA Job screen 
and other larger screens. Set up simple layouts for 
different user groups for many different screens.

Buttons can be hidden entirely, or less-used buttons 
can be moved to a More menu. Activate this for the user 
under user interface on the User screen.

The configuration is done from the Button Layout 
Screen. See the screenshot for the list of screens where 
the functionality is available.
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The Administrator

#38 
The administrator can add the users’ domain names to 
their account in SERTICA. This will make login faster as 
no password is required.

#37 
The administrator can setup secure passwords and 
password expiration in options under Global Options → 
Security → Security Settings.
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#39 
The administrator can enable auto logoff to enhance 
security. It is possible to control the time of inactivity 
before users will be logged out. This can be configured 
in options.

#41 
When publishing a Management System, it is possible 
to email changes to relevant users. The changes will 
be included in the mail as a PDF file. Controlled copies 
should be used for this. See chapter 4.3 of user guide to 
get help setting up the controlled copies.

#42 
The MS Browser screen in SERTICA can show bookmarks 
from documents. This makes it possible to import and 
view document bookmarks inside SERTICA. It is possible 
to navigate between them and easy get to the right 
place in the document. This can be activated in options.

#40 
You can disable transaction size limit on Management 
System Documents. MS Documents are important, 
and it is crucial that they are synchronized to vessels. 
This will ensure that SERTICA always sends them to 
vessels. The size limit can be activated in options by the 
administrator.
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#43 
You always have access to updated manuals. There is a 
very generic help file inside SERTICA and How-To guides 
and e-leaning guides can be found on SERTICA Web 
library. Contact support if you need a manual.

#44 
Sign up to the newsletter What’s New and get 
information about new functionality in your inbox. 

What’s New in SERTICA: File → Help → What’s New 
(internet access required).
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#45 
Contact support for further instructions: 
support@sertica.com

Get help
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